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Input data for Infinium 
arrays



iSCAN data
Results for 1 array

(24 samples)

Sample sheet(s) 
(.csv or .xls(x)format)

Manifest file received separately (.bpm format; describes probe content of the array)



iSCAN data

Results for
1 sample

In result folder of an array



Sample sheet

Run info

Manifest info

Samples info



Sample sheet – sample 
data

Sample’s name

Sample's original 
position in plate

Array number* 
(matches folder 
name)

Sample's position
on array (matches 
filenames of sample)

Often not filled in!

*Sometimes saved as
‘scientific number’ and 

last digits can get lost 
when saved as “.csv” file
(make a “.xls(x)” copy!)



Sample sheet – sample 
data
• Sample_ID, SentrixBarcode_A and SentrixPosition_A

are required, other columns are optional and many 
user-defined columns can be added, e.g.:

• Alternative names
• Tissue source
• Subpopulation
• Sample quality/ploidy (when known)

• Parent names must match names used under 
Sample_ID (if present in data set)



Sample sheet –
sample_ID
• Check ‘Sample_ID’ of samples

• Sometimes typing errors occurred

• Many software don’t accept spaces in names
• Create new ‘Sample_ID’ column and save original Sample_ID

as ‘Sample_ID_Original’
• Remove spaces from new ‘Sample_ID’ column
• Optional: Create abbreviated names for long names

• Parent and replicates names must match names used 
under new Sample_ID (if present in data set)



Sample sheet – sample 
data

• Replicates
• Keep one original name

• Easy to find in files generated in next steps

• Add rep numbers for other replicates
• Refer to original name as replicate

Will lead to 2 versions
of same report



Combining sample sheets
• Move all array result folders into same folder (needed to 

load data)
• GenomeStudio does not allow result folders to be spread across multiple 

subfolders

• Open first sample sheet and save first as new “.xls(x)” file 
(avoid loss of original sample sheet fila and loss of array 
number)

• Make sure data columns match
• Paste data rows below existing data,

• Repeat until all data is included



GenomeStudio®



Loading Data



GenomeStudio
Previously made projects

Start new project



Loading data

Location to save project

Name project



Loading data
1 sample sheet file is loaded here

Manifest location: Folder that contains all 
needed manifests

Data location: Folder that 
contains all needed 
SNP array folders



Loading data

A file designating custom or 
pre-set cluster positions can 
be loaded here instead of the 
default auto-clustering

Cluster SNPs

-0.15 is standard
-Defines area within which 
individuals will get a 
genotype call (outside will 
be ‘no calls’)
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Adding additional 
samples

• File > Load Additional 
Samples…

• Same process as before



First look at data



GenomeStudio® Layout

SNP Graph

Full Data Table, SNP Table, and Paired Sample Table

Error Table
Samples Table



SNP Graph
Tools to select individuals 
and move graph around

AA BBAB

Switch to Cartesian 
coordinates
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Full data table

SNPs

Copy     Export     Plotting functions        filter/unfilter sample columns    

Import (additional 
columns) Column Chooser

Position in 
SNP Graph

Genotype CallQuality score



SNP data table

How well did the SNP perform?

Was the SNP polymorphic?

Are parents and offspring matching?
(see later)

“Array specific” data



• All columns of sample sheet

• Sample statistics (need to calculated)

• Linked with SNP graph
• Selecting in table will highlight in SNP graph and 

vice versa 

Sample Table



Error Table

• Shows errors between replicates and parent(s) 
and offspring

• Will be discussed further
• Linked to SNP graph

• Replicates: square
• Parent(s) and offspring: circle(s) and cross, respectively



Sample quality and ploidy
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Checking Sample Quality

• Visual inspection of SNP graphs
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Some individuals are 
regularly located outside 
main clusters
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More individuals outside
main clusters
*use ‘ctrl’ + left mouse clicks to add 
new individual to selection
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Checking Sample Quality
1. Histogram function of Full Data Table

Options greyed out?!



Checking Sample Quality
2. Select first individual 3. Choose “B Allele Freq” 4. Select individual again

*Allows for scrolling through ind.
*Use ‘up’ and ‘down’ keys to scroll through ind.



-Three (clear) peaks

-Barely any occurrences 
between three peaks

-No clear heterozygous peak

-Many occurrences between 
three peaks
(middle section looks ~ flat)

Sample with good quality

Sample with poor quality

Checking Sample Quality



-Three (clear) peaks
-- AA, AB, and BB

-Four peaks
--AAA, AAB, ABB, and BBB

Diploid sample

Triploid sample

Checking Sample Ploidy



• Other ploidy

Checking Sample Ploidy

Aneuploids

-Five peaks?
-Different from poor quality?
-Could be a mix of 2 samples

-3 peaks + 2 small peaks?
-Not easy to see

Aneuploid sample

Tetraploid sample



Chagné et al. (2015) method

2. Apply the following filter parameters (continued on next slide):

Call Freq ≥ 0.90 Only SNP that have good call rate
Minor Freq >0.01 Only polymorphic SNPs
50% GC ≥ 0.40 Only SNPs for which most individuals were close to main cluster
GenTrain ≥ 0.65 Only SNPs with good overall clustering
ClusterSep ≥ 0.40 Only SNPs with well separated clusters
AA T Mean ≤ 0.125 Only SNPs with AA cluster in expected position
AA T Dev ≤ 0.028 Only SNPs with 'narrow' AA cluster (no multiple clusters)

AB T Mean ≥ 0.375 
≤ 0.625 Only SNPs with AB cluster in expected position

AB T Dev ≤ 0.056 Only SNPs with 'narrow' AB cluster (no multiple clusters)
BB T Mean ≥ 0.875 Only SNPs with BB cluster in expected position
BB T Dev ≤ 0.028 Only SNPs with 'narrow' BB cluster (no multiple clusters)

1. Choose ‘Filter rows’ for SNP Table in GenomeStudio®



Note:
Manifest must be selected in ‘Columns’ 
section before subcolumns become available

Chagné et al. (2015) method
2. Apply the following filter parameters (continued):

2a. Choose parameter

2b. Choose operation 2c. Choose value

2d. Add to filter criteria

2e. Add remaining criteria
“AND” clause is added automatically

2f. Click ‘OK’ when all
criteria are added



Chagné et al. (2015) method
3. Go to Full Data Table and select ‘Column Chooser’
*Filtering of SNP Table remains for Full Data Table

5. Hide standard subcolumns
6. Show B Allele Freq subcolumn

7. Press ‘OK’

4. Hide any column except Index, 
Chr, Position, and sample columns



Chagné et al. (2015) method
8. Export table 9. Give a meaningful name, choose save 

location, and save as ‘.csv’ file

10. If asked, choose ‘Yes’ to export entire table 11. Choose ‘Yes’ to view file in Excel



Chagné et al. (2015) method

12. Convert Chromosome numbers 
to numeric system where applicable 13. Insert a new column in front of 

sample columns



14. Apply the following formula for 
the new column:
Cell value = 1,000,000,000 * ‘Chromosome 
number’ + ‘position on chromosome’
*Choose a power of 10 that is larger than any 
position on chromosome 

Chagné et al. (2015) method
15. Replace formula by fixed values
*Copy column and paste as values

16. Delete original chromosome and 
position column



Chagné et al. (2015) method

17. Save as new ‘.csv’ file:

File should look like this:
-1st column: SNP Identifier (e.g. SNP Index)
-2nd column: SNP position (including chromosome)
-3rd column – end: B-allele Freq of each individual

18. Copy R-script ‘bAllele Analysis.R’  (Suppl. 
Document 2) in same folder as newly created .csv file

19. Open R-script ‘bAllele Analysis.R’ in RStudio



Chagné et al. (2015) method
20. Change file-name on line 1 into correct name of newly created .csv file

21. Change name of pdf-output on line 2 into desired name

22. Change working directory into location that has .csv file and R script
*Under ‘Session’, choose ‘Set Working Directory’, then choose ‘To Source File Location’



Chagné et al. (2015) method
23. Run entire script
*Select all lines and press run

24. Open created pdf file
*It’s in the same folder as the R-script and the .csv file with the B Allele Frequencies

Poor quality Tetraploid? Aneuploid



Chagné et al. (2015) method
Without initial filtering in SNP Table

With initial filtering in SNP Table



Segmental aneuploids
• Lack a large segment of a chromosome

• Large extra segment?

• Cannot be identified with methods 
described above

• Will lead to many errors further on for 
one chromosomal segment



SNP subset



Creating input files ASSIsT
• Manual can be found under ‘…\ASSIsT_Win_v1.01\docs’

1. Open Report Wizard in GenomeStudio

Creating 1st input file (Final report)

3. Choose ‘redo with the best’ and 
‘10th Percentile GC score’

2. Choose Final Report 



Creating input files ASSIsT
4. Select all samples/arrays

5.-Set format to Standard
-Include the following columns:

GT Score, Theta, R
*Order should be the same as figure

-Select ‘Group by SNP’
-Select ‘Tab’ as delimiter

6. Save Report 



Creating input files 
ASSIsT

7. Open Report Wizard in GenomeStudio and choose DNA Report 

Creating 2nd input file (DNA report)

8. Choose ‘redo with the best’ and 
‘10th Percentile GC score’

9. Select all samples/arrays

10. Choose Sample ID

11. Save Report 



Input files ASSIsT
Creating 3rd input file (Pedigree file)

12. Create a three-column file:
-1st column has the individual’s name
-2nd column has the female parent
-3rd column has the male parent
-Header row should be “//SampleID [tab] Mother [tab] Father”

*Copy SampleID and parent columns from sample sheet into Notepad++ and add the header line
*Parents do not have to be included in sample list



Input files ASSIsT
Optional - Creating 4th input file (Map file)

13. Create a three-column file:
-1st column has the SNP’s name/SNP’s ID
-2nd column has the chromosome (numerical)
-3rd column has the position (physical (bp, Mbp) or genetic (cM))
-Header row should be “//SNPid [tab] Chromosome [tab] Position”

*Copy Name, Chr and Position from exported Full Data Table and convert chromosome to numeric 
if needed
*Use genetic position if available
*Give fictional chromosome number to chloroplast/mitochondrial/… SNPs



Running ASSIsT
1. Open ASSIsT



Running ASSIsT
2. In console section, click on ‘Select’ next 
to ‘Select Input Files’ 

3. Click on ‘…’ boxes to choose each file 
created earlier. Once each file is chosen, 
click ‘OK’. 



Running ASSIsT
4. In console section, click on ‘Set’ next to ‘Set 
Parameters’

5. Set Parameters as follows: -CP (F1) for (large) F1 population
-Germplasm in most other cases for us

Proportion of allowed missing data

How much can an individual’s call rate differ 
from population mean

How much segregation distortion is allowed?
*lower means more distortion is allowed

Proportion of allowed inconsistencies between 
child and parents per SNP

Maximum frequency to define an allele as rare
*Only when Germplasm is chosen

Parents (CP (F1), BCx) or grandparents (F2) of the 
analyzed experimental population.

Chromosome number
*Take “extra” chromosomes into account

Check for Null alleles and AB sub-clusters
*Only for CP (F1) and BC



Running ASSIsT
6. Run the analysis

Note: 
ASSIsT may stop responding when switching to 
other programs during the analysis. ASSIsT is 
still working and after a few minutes, it will 
show the results of the analysis



Results ASSIsT

Results for each SNP
Ordered by Classification, then by Chromosome and Position

Summary of the 
results

SNP Graph similar to GenomeStudio
*non-interactive



Results ASSIsT

# of excluded samples

SNPs used for further curation

Discarded SNPs*

*Note:
Shifted-Homo SNPs were added 
back in but many required 
manual adjustment of clustering



Export Results
1. Click on “Export” button in console section

2.-Choose the files you want (next slide)
-Choose folder to save files in
-Choose name for files
*Avoid spaces in file names



Export Results
Summarizes Parameter settings and 
Results (as shown on the right in ASSIsT)

Gives genotype for each 
individual and each approved
SNP

SNPs are ordered according to their position

Gives results of analysis for each SNP (as shown on the bottom in ASSIsT

Two files (.ped and .map) needed to run PLINK and identify unknown duplicates (see 
further)

Helps create FlexQTL files needed for further data curation (see next sessions)

Genotype score and individuals missaligned?!

Genotypes calls



duplicates



Known duplicates

1. Create Reproducibility and Heritability report
in GenomeStudio

2. Choose name and save file 



Known duplicates

Name Individual

Name Duplicate

Number consistent 
genotype calls

Number inconsistent 
genotype calls

Proportion inconsistent 
genotype calls

1. Open Reproducibility and Heritability report
Duplicate comparison found under ‘Duplicate Reproducibility’



Finding unknown 
duplicates

1. Copy .ped and .map file into PLINK folder
ASSIsT output

2. Hold ‘shift’ and right click in the PLINK folder to get 
a. the “Open command window here” option
b. the “Open PowerShell window here” option

a b

3. (left) click on “Open command window here”/”Open PowerShell window here” to open 
the respective window



Using Plink – a. command window

Input file characterization
--file filename Define files, change filename to name of ped and map file
--no-fid when FID column is missing
--no-sex when sex column is missing
--allow-no-sex when sex column is missing, needed for some analyses
--no-pheno when phenotype column is missing
--missing-genotype N Define missing genotype (N) when different from 0
Analysis
--genome full calculate IBD (IBS) for all individuals

Expects same name for .ped and .map file
*e.g. Sweet_Cherry_6+9K.ped and 
Sweet_Cherry_6+9K.map
*NO blank spaces in name

4. Start with “plink.exe” then add additional commands with space between each. Press 
enter when all commands are given
*change “filename” to name of .ped and .map file



Input file characterization
--file filename Define files, change filename to name of ped and map file
--no-fid when FID column is missing
--no-sex when sex column is missing
--allow-no-sex when sex column is missing, needed for some analyses
--no-pheno when phenotype column is missing
--missing-genotype N Define missing genotype (N) when different from 0

Analysis
--genome full calculate IBD (IBS) for all individuals

Expects same name for .ped and .map file
*e.g. Sweet_Cherry_6+9K.ped and Sweet_Cherry_6+9K.map
*NO blank spaces in name

4. Start with “.\plink.exe” then add additional commands with space between each. Press 
enter when all commands are given
*change “filename” to name of .ped and .map file

Using Plink – b. PowerShell window

Expects same name for .ped and .map file
*e.g. Sweet_Cherry_6+9K.ped and 
Sweet_Cherry_6+9K.map
*NO blank spaces in name



Using Plink
5. Open plink.genome with Excel

6. Select first column, use “Text to Columns” to create separate columns

7. Sort according to the “PI_HAT” column, “Largest to Smallest”



Plink Results
Individual 1 Individual 2 IBS

0.97 as cutoff for duplicates



Duplicate triploids

• Calls should be the same between 
duplicates

• Are AB calls identical?
• Could be AAB or ABB
• B allele frequency

• Should both be 0.33 or 0.66
• Correlation between identically called 

individuals
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Pedigree check



Checking parent-child 
relationships

1. Open ‘Reproducibility and Heritability’ report created earlier for known duplicates
A. Parent-child errors found under ‘P-C Heritability’

Name ParentName child
Number genotype 
calls without PC error Proportion genotype 

calls with PC error

Number genotype 
calls with PC error

Only when parent in 
dataset



Checking parent-parent-
child relationships

Name Parent 1
Name child

Number genotype 
calls without PC error

Proportion genotype 
calls with PPC error

Number genotype 
calls with PPC error

Name Parent 2

1. Open ‘Reproducibility and Heritability’ report created earlier for known duplicates
B. Parent-child errors found under ‘P-P-C Heritability’



Finding new P(P)C 
relationships

1. Open ASSIsT’s “.gtypes” output in Excel 2. Ensure genotypic data aligns with 
individuals’ ID

3. Copy and transpose data so that individuals 
are in rows and markers in columns



Finding new P(P)C 
relationships

4. Bring in pedigree information for all individuals 
(parents do not have to be included in data set)

6. Use “Ind”, “Parent1” and “Parent2” as column headers

7. Save file as “.csv” in same folder as “Parent Check” R script (Suppl. 
Document 2)

5. Set missing parents to “-”



Finding new P(P)C 
relationships

8. Load libraries in R

9. Define functions in R by running them

10. Set working directory to source file location



Finding new P(P)C 
relationships

11. Define:
 Possible Alleles under AlleleList

 $ or $$ does not work for null alleles
 Characters used for missing genotypes under “MissGT”
 Characters used for missing alleleles under “MissAllele”

12. Provide filename and load into R

13. Run “FindPosParComb”

Loaded data file

Threshold to accept PC relationship

Threshold to accept PPC relationship

3 steps:
-Identify possible mothers for ind. with missing mothers
-Identify possible fathers for ind. with missing fathers
-Identify parents for ind. with both parents missing



Checking and finding grandparent-
grandchild relationships

• Excel - Suppl file 1 from van de Weg et al. (2018)
• If offspring is ‘AB’ and

• 1 known parent is ‘AA’ OR
• Two known grandparents through single parent are both ‘AA’

• Then: one unknown grandparent cannot be ‘AA’
• Minimize ‘AA’ calls gives indication of possible grandparent
• For any ‘AA’ in putative grandparent, second unknown 

grandparent cannot be ‘AA’

• Also true for ‘AB’ in individual and ‘BB’ in known 
parents/grandparents

van de Weg E, Di Guardo M, Jansch M, Socquet-Juglard D, Costa F, Baumgartner I, Broggini GAL, Kellerhals M, Troggio M, Laurems F, Durel CE, 
Pattochi A. (2012) Epistatic fire blight resistance QTL alleles in the apple ‘Enterprise’ and selection X-6398 discovered and characterized through 
pedigree-informed analysis. Molecular Breeding 38:5



van de Weg et al. (2018) 
method

2. Filter parent 1 for AA1. Filter individual for AB 3. Parent 2 should have 0 AA



Curating remaining 
Mendelian-inconsistent 
errors



FlexQTL Data Prepper



FlexQTL Data Prepper

• FlexQTL Data Prepper
• Requires 3 input files

• Marker file
• Adjusted ASSIsT output file

• Pedigree file
• Adjusted ASSIsT input file

• Data file
• Generated by ASSIsT



FlexQTL Data Prepper
Creating 1st input file (Marker file)

1. Create a three-column file:
-1st column has the SNP’s name/SNP’s ID
-2nd column has the chromosome (numerical)
-3rd column has the genetic position (cM))
-Header row should be “MarkerId”, “Group”, “Position”
-Save as “.csv” file

*Start from “…_plink_in.map” ASSIsT output file
*Change header row
*Change physical position to genetic position if needed



FlexQTL Data Prepper
Creating 2nd input file (Pedigree file)

2. Create a three-column file:
-1st column has the individual’s name
-2nd column has the female parent
-3rd column has the male parent
-Header row should be “Name”, “Parent1”, “Parent2”
-Save as “.csv” file

*Start from ASSIsT pedigree input file
*Change header row



FlexQTL Data Prepper
Creating 3rd input file (Data file)

3. Adjust “…_FQ_DataPrepper.txt” file format from “.txt” to “.csv”

Note:
If file format extension is not visible, enable it under the “View Tab” in the file’s folder

4. Open “…_FQ_DataPrepper.txt” file in Excel



FlexQTL Data Prepper
5. Adjust header row so it matches genotypic data

6. Change cell A1 to “ID”

7. Save file



FlexQTL Data Prepper
8. Open FlexQTLDataPrepper.exe

9. Load marker file
10. Load pedigree file
11. Load data file

12. Choose output 
directory

13. Select this option

14. Press ‘Go’



FlexQTLTM Input files



FlexQTLTM input files

• Three files
• Data file (.dat)
• Map file (.map)
• Parameter file (.par)
• Text-based files
• Everything after “;” will be ignored

• Easy excluding of rows in file



FlexQTLTM input files
• Data file (.dat file)

• No header needed (if added, start with “;”)
• Column 1: Population
• Column 2: Individual
• Column 3: Parent 1 
• Column 4: Parent 2

• Both parents needed (or none)
• Use dummy individuals when only one parent is available

• Column 5 – X: nuisance variables
• Columns X+1 – Y: Phenotypic variables
• Columns Y+1 – End: Genotypic data

• Two columns per marker
• One column per marker with space(s) between alleles



FlexQTLTM input files

• Map file (.map)
• Column 1: marker name
• Column 2: genetic position within LG

• Each LG starts with “group X”
• X is LG number

• Identical number of markers needed as in 
data file



FlexQTLTM input files

• Parameter file (.par)
• Always called “flexqtl.par”
• Defines parameters for FlexQTL

• Some are adjusted automatically through Visual 
FlexQTL (see further)

• Some can be adjusted within FlexQTL
• Need to be “correct” when running FlexQTL

independently from Visual FlexQTL
• E.g. on Linux



FlexQTLTM input files

• FlexQTL Data Prepper output needs 
additional adjustments

• Parents without genotype data need to be 
added

• Every individual in pedigree needs a data row 
for FlexQTL

• Individuals with only one known parent need 
a second dummy parent

• FlexQTL only accepts no or 2 parents known



FlexQTLTM input files

1. Open “.csv” file generated by FlexQTLDataprepper

2. Find individuals with only one parent known/given and add a second ‘dummy’ parent
-Use “M_[Individual’s name]” for unknown mother
-Use “F_[Individual’s name]” for unknown father
-Use “UP_[Individual’s name]” if unclear whether known parent is mother or father

Adjusting FlexQTLDataPrepper file to create 1st FlexQTL input file 
(data file)



FlexQTLTM input files
3. Open “.csv” file generated by FlexQTLDataprepper

4. Copy both parental columns (columns C and D) to a new sheet

5. Copy “Parent 2” column below “Parent 1” column

6. Remove duplicates* from combined column
*found under “data” tab in Excel



FlexQTLTM input files
7. Count how often each parent is in datafile:

use “COUNTIF” function
Range is “Individual” column (column B) of original sheet
Criteria is parent to be checked (from created column in new sheet)

8. Filter for individuals not in the data file (count = 0)



FlexQTLTM input files
9. Copy parents not in data file at the bottom of the data file

10. Fill in “Population” column (Column A), “Pedigree info” (Column C and D), and 
Genotypic data columns (Column E onwards) of added parents

-”0” for unknown pedigree
-Make sure newly-added pedigree info is also in data set
-“- -” for genotypic data



FlexQTLTM input files
11. Add 2 columns between parentage information (Column C+D) and genotypic data 
(Column E)

14. Copy full data sheet into text editor (e.g. Notepad++)

12. Fill 1st new column (Column E) with “1”s
*Used as dummy nuisance column

15. Save file in text format

16. Change new file’s format extension from “.txt” to “.dat”

13. Fill 2nd new column (Column F) with random numeric values
*Used as dummy phenotype column



FlexQTLTM input files
2nd FlexQTL input file (map file)

17. Use flexQTL.map file generated by FlexQTL Data Prepper

3rd FlexQTL input file (parameter file)
18. Save Suppl. Table 4c as text file

* “datafile”, “mapfile”, “indiC” and “nmrkrC” parameter settings will be updated 
automatically when loading files into Visual FlexQTL

19. Change file extension from “.txt” to “.par”

20. Change file name to “flexqtl”
FlexQTL does not accept any other name!



Installing (Visual) FlexQTLTM



Installation

• Install Visual FlexQTL
• Will also install FlexQTL

• Install following packages in R
• Data.tables
• Plyr
• Lattice



Installation
• Tools > Settings

• General Tab
• Where is Rscript.exe on pc
• Where is flexqtl_console.exe on pc
• Where is postqtl_console.exe on pc
• Where can license be founds

• Needs updating every year



Installation – Win8 or later

• Install Visual C++ Redistributable for 
Visual Studio 2012

• https://www.microsoft.com/en-
us/download/details.aspx?id=30679

Most new pc 
need this one



Finding Mendelian-
inconsistent errors



Creating project in 
Visual FlexQTLTM

1. Open Visual FlexQTLTM

2. Under “File”, choose “New Project”

3. Choose name for project

4. Choose project directory

Filled in automatically

4. Load parameter file
5. Load map file
6. Load data file

6. Press “OK”



Creating project in 
Visual FlexQTLTM

1. Open Visual FlexQTLTM

2. Under “File”, choose “New Project”

3. Choose name for project

4. Choose project directory

Filled in automatically

4. Load parameter file
5. Load map file
6. Load data file

6. Press “OK”



Checking parameter 
settings

7. Check parameter settings under the ‘Settings’ tab

Checked to allow for segregation distortion

Unchecked to keep genotypic data for 
single marker double recombinations

“2” for an early stop; generates files for 
error checking but does not do full 
FlexQTLTM analysis (can take days)

8. Press “Save” if any values were changed



Running FlexQTLTM

8. Run FlexQTL (Tools>Re-run FlexQTL)

9. Once run, go to project directory and open “mconsistency.csv”

10. Save file in “.xls(x)” format



Mconsistency.csv

Consistensies and errors 
reported by the mconsistency
file

Summary of errors found in 
data set

Information found in mconsistency file (1)



Mconsistency.csv
Summary of errors 
found for each individual

Summary of errors found 
for each marker

Observation (consistent genotype or 
erroneous genotype) for each individual 
and marker combination

Information found in mconsistency file (2)



Mconsistency.csv
11. Copy data from row 15 onward and all columns

12. Transpose copied data in new sheet



Mconsistency.csv
13. Sum all errors for each marker in column C

14. Add filter and filter for markers with at least 1 error
*optional: sort full data according to number of 
errors from high to low

15. Copy all data and transpose into new sheet
*original mconsistency format but only markers with 
errors are kept



Mconsistency.csv
16. Freeze panes so that summary for each marker and individual is locked

17. Add filter to last summary row

Locked by 
freezing panes

Filter added



Mconsistency.csv
18. For each marker, filter for characters that are associated with an error to find which 
individuals are causing an error in column A

Error-associated characters

Filtered for error-associated characters

Individuals who caused an error for this 
marker

*Could also be their parents (or 
ancestors if parents have missing data)
*Could also be their offspring (very 
often the case)



Resolving errors
19. Check genotypic data to find what is causing the issue

*Note: sometimes imputed missing data is causing the issue
e.g. parental genotypic data is missing but grandparents are both “AA” ->

parent is imputed as “AA” however individual is “BB” ->
error reported
*Note: In case of multiple parents/ancestors with missing data that 
prevented earlier pedigree checking, pedigree could still be incorrect

20. Check GenomeStudio® to:
-Ensure genotypic data matches
-Genotype clustering is correct (e.g. additional clusters or null alleles observed)
-Single individuals are assigned the correct genotype

Incorrect clustering Incorrect clustering due to 
additional clusters

Incorrect clustering due to 
null alleles



Resolving errors
21. Update data file (pedigree or genotypic data)

*Update map file if markers were removed from data set

22. Re-run FlexQTLTM and check mconsistency file to ensure errors are resolved

22. Repeat until no errors are reported



Finding Mendelian-
consistent errors



Finding double 
recombinations

1. Run FlexQTLTM with latest map and data file that did not lead to any reported errors
*Parameter settings remain the same

2. Set interval for which double recombinations (DR) (Tools>Calculate>(Re-)Compute 
recombination sequences)

*Default is all DR within 10 cM



3. Export all double recombinations within defined interval (Tools>Export>Export 
recombination sequences file; then select directory to save file in)

4. Open generated file called “DoubleRecombinations.csv”

5. Save as “.xls(x)” format

Finding DR



Finding DR
Information found in DoubleRecombinations file

Individual in which DR is observed

Chromosome on which DR is observed

Homolog on which DR is observed
0: Homolog coming from mother
1: Homolog coming from father

-M/P1: Last marker name(M)/position(P) 
before 1st recombination

-M/P2: First marker name(M)/position(P) 
after 1st recombination

-M/P3:Last marker name(M)/position(P) 
before 2nd recombination

-M/P4: First marker name(M)/position(P) 
after 2nd recombination

Length of DR interval

How suspicious/unlikely is this DR



Finding DR
5. Sort file according to chromosome and position of DR

6. Look first for regions with many DR

7. Use ‘Segregation Indicator Pattern’ tab of Visual FlexQTLTM to visualize DR
Use drop-down menu on top-right to choose “Recombination sequences (based on 
FlexQTL SIP)



Investigating DR

2 lines for each individual, 
one for each parent’s 
homolog

Individual’s name

Parent’s name

Indicator of grandparental origin:
-0: Allele originates from mother of parent (grandmother; yellow)
-1: Allele originates from father of parent (grandfather; blue)

Recombination region (0-to-1 
or 1-to-0 switch; orange)

DR region (0-to1-to-0 or 
1-to-0-to-1 switches; red)

Information found under “Segregation Indicator Pattern” tab 



Resolving DR
8. Check genotype calls with GenomeStudio®

-e.g. incorrect clustering of “AA” as “AB” ->
“AB” (actually “AA”) x “AB” -> 100% “AB” (actually 50% “AA” and 50% “AB”)
*does not lead to PPC errors
*often characterized by many DR in a single or few families
*often characterized by a single marker involved in DR

-single genotyping error in individual
*does not lead to PPC errors
*often characterized by many DR in offspring of this individual
*often characterized by a single marker involved in DR

Incorrect clustering



Resolving DR
9.a Check for errors in map order using the “Segregation Indicator Pattern” tab 

Moving marker(s) a few positions resolves DR
*Characterized by DR in a few individuals who are not necessarily related
*Characterized by DR spanning one or multiple markers
*Often characterized by a third recombination nearby

moving markers to this recombination would solve DR

DR

3rd recombination

Moving markers “201” and “4581” behind 
marker “2565” would resolve these DR 

*This cannot create new DR for other 
individuals (next slide)



Resolving DR
9.b Adjust marker position and check if no new DR are created

9.b.1 Open “SIP_Population_X.csv” in FlexQTL project folder
*“X” is highest number found in folder
*Interpretation the same as “Segregation Indicator Pattern” tab of Visual FlexQTLTM

9.b.2 Use conditional formatting to color “0”/“s0” yellow and “1”/“s1” blue
*same coloring as “Segregation Indicator Pattern” tab of Visual FlexQTLTM



Resolving DR
9.b Adjust marker position and check if no new DR are created

9.b.1 Open “SIP_Population_X.csv” in FlexQTL project folder
*“X” is highest number found in folder
*Interpretation the same as “Segregation Indicator Pattern” tab of Visual FlexQTLTM

9.b.2 Use conditional formatting to color “0”/“s0” yellow and “1”/“s1” blue
*same coloring as “Segregation Indicator Pattern” tab of Visual FlexQTLTM



Resolving DR
9.b.3 Cut columns of markers to move and insert them into new position

9.b.4 Check rest of the file (rows) to make sure this move did not create additional DR

9.b.5 Update “.dat” and “.map” file to reflect the change in marker positions



Resolving DR
10. Check for phasing issues

*Often characterized by DR in almost all offspring of a single individual
*Individuals is often a founder (parents not genotyped)
*One or more offspring have a single recombination for same marker(s)

*Incorrect phasing of this individual causes errors for sibs

Marker always involved in DR

One individual with single recombination
*Make  genotypic data of this individual 
missing (gets imputed again in later stages)

Incorrect phasing – short recombination interval

Correct phasing – long recombination interval

Probable cause: minimizing recombination interval



Resolving DR
11. Re-run FlexQTLTM and re-generate “DoubleRecombinations.csv” file with Visual 
FlexQTLTM after resolving major DR 

*Resolving DR may resolve other nearby DR

12. Repeat these steps until remaining DR are very likely true
*Unlike Mendelian-inconsistent errors, some DR can remain



Haploblocking and 
haplotyping



Generating haploblocks



Adjusting input files

• Accurate phasing requires:
• Removal of intermediate ungenotyped 

progenitors
• Well-represented ancestors (>3 offspring) 

whose genotype can be imputed can remain

• Haploblock determination based on 
historical recombination requires:

• All individuals that need to be taken into 
account to have offspring in data set



Adjusting input files
1. Remove any parentage information of ungenotyped intermediate progenitors 
from FlexQTLTM data input file

*Ungenotyped founders (no known parents) can stay in data set
*Ungenotyped progenitors with more than 3 genotyped offspring can stay in 
data set

2. Add dummy offspring to FlexQTLTM data input file for any individual whose 
recombination are important for haploblock determination (e.g. breeding 
selections) that don’t have any offspring in the data set

*Set genotypic data of dummy individuals to missing
*Set parents of dummy individuals to individuals who need offspring in data 
set



Creating haploblocks
3. Create a new FlexQTLTM project and use following settings

• skipSampleMarkers: 0
• REDprint: 0
• Markerblock: 5
• MSegDelta: 1
• DeleteDR: 1

4. Run FlexQTLTM

5. Generate haploblock delimitation with Visual FlexQTLTM (Tools>Export>Export 
haplotype blocks file then select directory to save file in)



Creating haploblocks
6. Open generated HaploBlock.map file

7. Adjust Haploblock designations as wanted
e.g. to ensure maximum size of haploblock is 1 cM

Assigned haploblock
*name can be 
changed freely



Determining haplotypes



Creating input files
1. Remove dummy offspring from FlexQTLTM data input file used for haploblock 

determination

2. Create a new FlexQTLTM project and use following settings
• skipSampleMarkers: 0
• REDprint: 0
• Markerblock: 5
• MSegDelta: 1
• DeleteDR: 1

3. Run FlexQTLTM



Creating input files
4. Copy needed input files in a single folder

*From latest FlexQTLTM run:
• mhaplotypes.csv
• flexqtl.par
• flexqtl.sort

*From FlexQTLTM run to determine haploblocks:
• Generated (and adjusted) haploblocks.map

5. Create a new R project in the same folder to run PediHaplotyper



Running PediHaplotyper
6. In RStudio, install PediHaplotyper as a package (only needed once)

*Tools>Install Packages…
*Install from: “Package Archive” and Browse to find “PediHaplotyper_1.tar.gz” 

7. Set working directory to “Source File Location”



Running PediHaplotyper
8. Run the following code

Prefix for all output files Name of haploblock definition file



Output files
“orig”-flag vs “final”-flag

-“orig”: results after initial haplotype determination
-“final”: results add end of haplotype determination (use these files)

“mrk”-flag vs “hb”-flag
-“mrk”: results at the single marker level
-“hb”: results at haplotype level (use these files)



Output files
-All three FlexQTLTM input files (“.dat”, “.map”, and “.par”) created for each combination

-Pedimap input file (“.ped”) created for each combination

- “[…] _hballeles.dat” gives definition of each haplotype for each haploblock

Haploblock number and name

Number of markers in haploblock

Haplotype name and number Missing values within haplotype How often haplotype occurs in data set

Marker names within haploblock

Marker alleles that create haplotype



Checking for errors in 
haplotypes



Mendelian-inconsistent 
errors
1. Use “[….]_finalhb” FlexQTLTM input files generated by PediHaplotyper to create a 

new FlexQTLTM project
*parameter file should be renamed to “flexqtl.par”

2. Use “mconsistency.csv” file to identify issues

3. Use “[…] _hballeles.dat” file to investigate haplotypes that cause P(P)C errors
3.a If missing data within haplotype causes inconsistency: assign correct 
haplotype (if both parental haplotypes are possible, use information on flanking 
markers and minimize recombinations)

HB-09-10 439 6324 3144 6325 3146
4 A B A B A
5 B B A A B
6 B B A A -

Haplotype 6 equals haplotype 5 
except for a missing value



Mendelian-inconsistent 
errors
3.b If a recombination occurs within haploblock:

3.b.1 if recombination occurs within selected material: adjust haploblock
borders in “haploblock.map” file and re-determine haplotypes for 
adjusted haploblocks

3.b.2 if recombination occurs in seedling: don’t adjust haploblock borders and 
do not adjust haplotype (or make it missing)

Recombination within HB 

HB-01-21 1970 4277 131 2566 6846
4 A B A A A
5 A B B A B
6 A B A A B



Mendelian-inconsistent 
errors

3.c If a genotype calling error occurred (check with GenomeStudio®): adjust 
haplotype to resemble correct genotype call

3.d If a marker order is incorrect: adjust marker order in “haploblock.map” file, 
and latest data and map file for single marker level. Re-run FlexQTLTM to create 
new PediHaplotyper files and rerun pedihaplotyper for affected haploblocks



Mendelian-consistent 
errors

4. Once Mendelian-inconsistent errors are resolved, check for Mendelian-
consistent errors as was done for single marker level

5. Resolve Mendelian-consistent errors as was done for Mendelian-inconsistent 
errors with haplotypes

6. Enjoy your high-quality genotypic data set and make lots of great discoveries!!


